Maintenance and Troubleshooting Guide
© Copyright 2005, Applied Biosystems. All rights reserved.

For Research Use Only. Not for use in diagnostic procedures.

Information in this document is subject to change without notice. Applied Biosystems assumes no responsibility for any errors that may appear in this document. This document is believed to be complete and accurate at the time of publication. In no event shall Applied Biosystems be liable for incidental, special, multiple, or consequential damages in connection with or arising from the use of this document.

NOTICE TO PURCHASER:

This instrument is Authorized for use in DNA sequencing and fragment analysis. This authorization is included in the purchase price of this instrument and corresponds to the up-front fee component of a license under process claims of U.S. Patent Nos. 5,821,058 and 5,332,666 and under all process claims for DNA sequence and fragment analysis of U.S. patents now or hereafter owned or licensable by Applied Biosystems for which an Authorization is required, and under corresponding process claims in foreign counterparts of the foregoing for which an Authorization is required. The running royalty component of licenses may be purchased from Applied Biosystems or obtained by using Authorized reagents purchased from Authorized suppliers in accordance with the label rights accompanying such reagents. Purchase of this instrument does not itself convey to the purchaser a complete license or right to perform the above processes. This instrument is also licensed under U.S. Patent No. 5,171,534 and apparatus and system claims in foreign counterparts thereof. No rights are granted expressly, by implication or by estoppel under composition claims or under other process or system claims owned or licensable by Applied Biosystems. For more information regarding licenses, please contact the Director of Licensing at Applied Biosystems, 850 Lincoln Centre Drive, Foster City, California 94404, USA.

NOTICE TO PURCHASER:

The purchase price of the Applied Biosystems 3730 and 3730xl DNA Analyzers includes a grant of a limited, non-transferable license under U.S. Patent No. 5,567,292 and method claims of its foreign counterparts, and under U.S. Patent No. 6,358,385 and element claims of its foreign counterparts, to use this particular instrument for electrophoresis methods employing fluorescence as a means of detection. No other licenses or rights are hereby conveyed either expressly, by implication, or by estoppel including, but not limited to, any claims to a composition.

The Applied Biosystems 3730 and 3730xl DNA Analyzer includes patented technology licensed from Hitachi, Ltd. as part of a strategic partnership between Applied Biosystems and Hitachi, Ltd., as well as patented technology of Applied Biosystems.

TRADEMARKS:

Applied Biosystems is a registered trademark of Applera Corporation and AB (Design), POP-7, and iScience are trademarks of Applera Corporation or its subsidiaries in the U.S. and/or certain other countries.

Microsoft, Windows, and Windows XP are registered trademarks of the Microsoft Corporation.

Oracle is a registered trademark of the Oracle Corporation.

All other trademarks are the sole property of their respective owners.

4359473 Rev. B

04/2005
## Contents

<table>
<thead>
<tr>
<th>Preface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1</td>
</tr>
<tr>
<td>Maintenance Schedules</td>
</tr>
<tr>
<td>Maintenance Wizards Overview</td>
</tr>
<tr>
<td>Typical Conditions for Using Maintenance Wizards</td>
</tr>
<tr>
<td>Cleaning the Pump Block and Lower Polymer Block</td>
</tr>
<tr>
<td>Flushing and Filling the Water Trap</td>
</tr>
<tr>
<td>Storing a Capillary Array</td>
</tr>
<tr>
<td>Performing a Short-Term Shutdown</td>
</tr>
<tr>
<td>Maintaining Adequate Space for Database and Sample Data Storage</td>
</tr>
<tr>
<td>Deleting Data from the Database</td>
</tr>
<tr>
<td>Defragmenting the Computer Hard Drive</td>
</tr>
</tbody>
</table>

| Chapter 2 | **Troubleshooting** | 25 |
| Spatial Calibration | | 25 |

| Index | 29 |
How to Use This Guide

Purpose of This Guide

This guide is written for the training of principal investigators and laboratory staff who operate and maintain the Applied Biosystems 3730/3730xl DNA Analyzers.

Assumptions

This guide assumes that you have:

- Familiarity with the Microsoft® Windows® 2000 and/or Microsoft® Windows XP Professional operating systems.
- Knowledge of techniques for handling and preparing DNA samples for sequencing.
- A general understanding of hard drives and data storage, file transfers, and copying and pasting.

Text Conventions

This guide uses the following conventions:

- **Bold** indicates user action. For example:
  
  Type 0, then press **Enter** for each of the remaining fields.

- **Italic** text indicates new or important words and is also used for emphasis. For example:
  
  Before analyzing, *always* prepare fresh matrix.

- A right arrow bracket (>) separates successive commands you select from a drop-down or shortcut menu. For example:
  
  Select **File > Open > Spot Set**.
  
  Right-click the sample row, then select **View Filter > View All Runs**.

User Attention Words

Two user attention words appear in Applied Biosystems user documentation. Each word implies a particular level of observation or action as described below:

**Note:** Provides information that may be of interest or help but is not critical to the use of the product.

**IMPORTANT!** Provides information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.
Examples of the user attention words appear below:

**Note:** The size of the column affects the run time.

**Note:** The Calibrate function is also available in the Control Console.

**IMPORTANT!** To verify your client connection to the database, you need a valid Oracle user ID and password.

**IMPORTANT!** You must create a separate Sample Entry Spreadsheet for each 96-well plate.

Safety alert words also appear in user documentation. For more information, see “Safety Alert Words” in the *Applied Biosystems 3730/3730xl DNA Analyzer Getting Started Guide* (PN 4359476).

### How to Obtain More Information

#### Related Documentation

The following related documents are shipped with the system:

- *The Applied Biosystems 3730/3730xl DNA Analyzer Getting Started Guide* – Provides step-by-step procedures for analyzing DNA samples. It is designed to help you learn to use the 3730/3730xl DNA Analyzer.

- *The Applied Biosystems 3730/3730xl DNA Quick Reference Card* – Provides a 6-page overview for using a 3730/3730xl DNA Analyzer. It is designed to help you find information quickly.

#### Send Us Your Comments

Applied Biosystems welcomes your comments and suggestions for improving its user documents. You can e-mail your comments to:

[techpubs@appliedbiosystems.com](mailto:techpubs@appliedbiosystems.com)
How to Obtain Support

For the latest services and support information for all locations, go to http://www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

• Search through frequently asked questions (FAQs)
• Submit a question directly to Technical Support
• Order Applied Biosystems user documents, MSDSs, certificates of analysis, and other related documents
• Download PDF documents
• Obtain information about customer training
• Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers to contact Applied Biosystems Technical Support and Sales facilities.
Maintenance Schedules

Overview
This section summarizes common tasks required to maintain your Applied Biosystems 3730/3730xl DNA Analyzer in good working condition. The tasks are organized according to how often you should perform them.

⚠️ **WARNING** Wear appropriate protection, including gloves, laboratory goggles, and coat whenever you work with the fluids used on this instrument or parts that may come into contact with these fluids.

⚠️ **WARNING** CHEMICAL HAZARD. Running Buffer with EDTA causes eye, skin, and respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

⚠️ **WARNING** CHEMICAL HAZARD. POP-7 polymer causes eye, skin, and respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

<table>
<thead>
<tr>
<th>Daily Maintenance</th>
<th>Task</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ensure that adequate levels of liquid are in the buffer, waste, and water reservoirs.</td>
<td>Before each run</td>
</tr>
<tr>
<td></td>
<td>Ensure the plate assemblies are properly assembled.</td>
<td>Before each run</td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT!</strong> The holes in the plate retainer must align with the holes in the septa, or the capillary tips will be damaged. Make sure the retainer clips are flush with the sides of the plate.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ensure the plate assemblies are properly positioned on the plate deck.</td>
<td>Before each run</td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT!</strong> Never use warped plates.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Check the level of buffer in the buffer jar and ensure that the overflow hole is not blocked, and that the overflow hole is facing toward the front of the instrument.</td>
<td>Before each run</td>
</tr>
</tbody>
</table>

Notes
## Chapter 1 Maintenance

### Maintenance Schedules

<table>
<thead>
<tr>
<th>Task</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace the buffer in the buffer jar, the water in the water reservoir, and 1X run buffer in the buffer reservoir on the instrument and, make sure that the outside of the assemblies are dry.</td>
<td>Every 48 hours</td>
</tr>
<tr>
<td>Check for bubbles in the pump block, lower polymer block, interconnect tube, polymer supply tube, and channels. Remove all bubbles using the Bubble Remove wizard (see page 5)</td>
<td>Daily or before each run</td>
</tr>
<tr>
<td>Check the loading-end header to ensure that the capillary tips are not crushed or damaged.</td>
<td>Daily or before each run</td>
</tr>
<tr>
<td>Check the level of polymer in the bottle to ensure that the volume is sufficient for runs.</td>
<td>Daily or before each run</td>
</tr>
<tr>
<td>Check the pump block and the lower polymer block to ensure that they fit securely on the instrument.</td>
<td>Daily</td>
</tr>
<tr>
<td>Clean the instrument surfaces.</td>
<td>Daily</td>
</tr>
<tr>
<td>Check for leaks around the array knob, interconnect tubing nuts, and check valve.</td>
<td>Daily</td>
</tr>
<tr>
<td>Replace the POP-7 polymer using the Change Polymer wizard.</td>
<td>Weekly</td>
</tr>
<tr>
<td>Check the storage conditions of the used arrays.</td>
<td>Weekly</td>
</tr>
<tr>
<td>Replace reservoir septa.</td>
<td>Weekly</td>
</tr>
<tr>
<td>Clean the buffer jar, water, waste, and buffer reservoirs with warm water followed with a thorough distilled/deionized water rinse.</td>
<td>Weekly</td>
</tr>
<tr>
<td>Flush the polymer delivery pump water trap (see page 10).</td>
<td>Weekly</td>
</tr>
<tr>
<td>Run the Water Wash wizard (see page 5).</td>
<td>Monthly or as needed</td>
</tr>
<tr>
<td>Flush the array port during the Water Wash wizard, whether or not bubbles are present in the array port.</td>
<td>Monthly or as needed</td>
</tr>
<tr>
<td>Clean the drip tray.</td>
<td>As needed</td>
</tr>
<tr>
<td>Change the capillary array using the Install Array wizard (see page 5).</td>
<td>As needed</td>
</tr>
<tr>
<td>Remove any dried polymer from the capillary tips. Use a lint-free wipe moistened with deionized water.</td>
<td>As needed</td>
</tr>
</tbody>
</table>

---

**Notes**

---
General Instrument Cleaning

To clean the instrument:
1. Ensure the oven door, the instrument door, and the stacker are closed.
2. Press the Tray button on the front of the instrument to move the autosampler to the forward position.
3. Wipe off any liquid on or around the autosampler using a lint-free tissue.
4. Clean out the drip tray with deionized water and lint-free tissue.
5. Clean off any polymer build-up (crystals) on the instrument including the capillary tips with deionized water and lint-free tissue.

**IMPORTANT!** Never use organic solvents to clean the instrument or any of its components.

Wizards Types and Functions

The five wizards in the Data Collection Software v3.0 guide you through several maintenance procedures. Access the Wizard drop-down menu by selecting: **GA Instruments >ga3730 >Instrument Name**.

<table>
<thead>
<tr>
<th>Wizard</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Array</td>
<td>• To install a capillary array:</td>
</tr>
<tr>
<td></td>
<td>– On a new instrument</td>
</tr>
<tr>
<td></td>
<td>– To reactivate an instrument that has been shut down</td>
</tr>
<tr>
<td></td>
<td>• To replace an installed capillary array with another capillary array</td>
</tr>
<tr>
<td></td>
<td>• To enter array information when the Data Collection software is reinstalled or upgraded</td>
</tr>
<tr>
<td>Change Polymer</td>
<td>• To replenish the polymer supply</td>
</tr>
<tr>
<td></td>
<td>• To replace the polymer in the polymer delivery pump with polymer of the same or different lot</td>
</tr>
<tr>
<td></td>
<td>• To enter polymer information when Data Collection software is installed or upgraded</td>
</tr>
<tr>
<td>Bubble Remove</td>
<td>• To remove bubbles in the polymer delivery pump chamber, channels, array ferrule, and tubing</td>
</tr>
</tbody>
</table>
### Water Wash

<table>
<thead>
<tr>
<th>Wizard</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water Wash</td>
<td>• To wash the polymer delivery pump chamber, lower polymer block*, channels, and tubing with water:</td>
</tr>
<tr>
<td></td>
<td>– As part of a monthly maintenance protocol</td>
</tr>
<tr>
<td></td>
<td>– To remove any suspected contaminants in the polymer delivery pump</td>
</tr>
<tr>
<td></td>
<td>– To remove persistent bubbles (followed by the Bubble Remove wizard, if needed)</td>
</tr>
<tr>
<td></td>
<td>– To replace old polymer in the polymer delivery pump</td>
</tr>
<tr>
<td></td>
<td>* The lower polymer block should not be removed; clean on the instrument using this wizard.</td>
</tr>
</tbody>
</table>

### Instrument Shutdown

<table>
<thead>
<tr>
<th>Wizard</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument Shutdown</td>
<td>• To prepare the instrument for a period of disuse of greater than one week</td>
</tr>
<tr>
<td></td>
<td>• To remove the array</td>
</tr>
</tbody>
</table>
Typical Conditions for Using Maintenance Wizards

<table>
<thead>
<tr>
<th>Condition</th>
<th>Applicable Wizard/Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The polymer has been in the pump longer than 1 week.</td>
<td>Use the Water Wash wizard (instead of Change Polymer wizard) to replace the polymer.</td>
<td>Using the Water Wash wizard ensures that the system is well cleaned before fresh polymer is introduced. Certain polymer components may decompose, causing an increase in electrophoresis current in polymer that has been at room temperature for more than 1 week.</td>
</tr>
<tr>
<td>Bubbles move but are not completely cleared by the Bubble Remove wizard.</td>
<td>Use the Bubble Remove wizard repeatedly until the bubbles are gone.</td>
<td>When clearing bubbles with repeated use of the wizard, note whether or not the target bubbles move during the wizard procedure. Any bubbles that move but are not entirely cleared by running the wizard are likely to be cleared with a repeat of the Bubble Remove wizard.</td>
</tr>
<tr>
<td>You want to clear persistent bubbles</td>
<td>Try one or both of the following: • Run the Water Wash wizard followed, if necessary, by the Bubble Remove wizard. • Remove the polymer bottle and then run the Bubble Remove wizard (a large amount of air is drawn into the pump chamber and other parts of the system). Reinstall the polymer bottle and repeat the Bubble Remove wizard to remove all bubbles.</td>
<td>• The Water Wash wizard includes refilling the pump with polymer. • If the pump sits idle for a time, bubbles that previously did not move are often cleared by running the Bubble Remove wizard.</td>
</tr>
<tr>
<td>Many or large bubbles are present in the pump chamber.</td>
<td>The Water Wash wizard may help to remove bubbles.</td>
<td></td>
</tr>
<tr>
<td>No bubbles are present in the array port during the monthly water wash procedure.</td>
<td>You should still perform the Flush Array Port procedure using the Water Wash wizard as part of monthly maintenance, even if no bubbles are present.</td>
<td>Occasional flushing of the array port keeps this space filled with fresh solution.</td>
</tr>
<tr>
<td>You want to install a capillary array on an instrument without an array.</td>
<td>Use the Install Array wizard.</td>
<td>Filling the array helps to ensure complete changeover to polymer after the polymer delivery pump has been washed with water.</td>
</tr>
<tr>
<td>You want to remove or install a capillary array.</td>
<td>Carefully follow the instructions in the appropriate wizard (Install Array or Instrument Shutdown wizard). Ensure that the instrument configuration and the database information agree.</td>
<td>A mismatch between the array configuration/identification and the database information may cause incorrect analysis parameters and result in reduced basecalling accuracy.</td>
</tr>
<tr>
<td>You select Discard during installation of an array using the Install Array wizard.</td>
<td>The information for that array cannot be entered again on the instrument.</td>
<td></td>
</tr>
</tbody>
</table>

Notes
### Chapter 1  Maintenance

#### Typical Conditions for Using Maintenance Wizards

<table>
<thead>
<tr>
<th>Condition</th>
<th>Applicable Wizard/Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>You plan to leave the instrument unused for more than 1 week.</td>
<td>Use the Instrument Shutdown wizard.</td>
<td></td>
</tr>
<tr>
<td>You are using the Install Array wizard to reactivate the instrument.</td>
<td>First power on the instrument power to activate the wizard menu in the Data Collection software.</td>
<td>The instrument must be powered on for the wizards to be available through the Data Collection software. If the instrument is turned off, the wizard names in the drop-down menu are grayed out.</td>
</tr>
<tr>
<td>You cancel a wizard during an automated procedure.</td>
<td>Wait until wizard step is complete.</td>
<td>The piston cannot stop immediately. During the period between cancellation and termination while the piston is in motion, a “Please wait...” dialog box displays.</td>
</tr>
<tr>
<td>You want to clean the polymer delivery pump</td>
<td>Use the Water Wash wizard with deionized water at ≤ 40 °C.</td>
<td>Hot water may damage the polymer delivery pump seals and joints. Do not use any solutions or fluids in the instrument other than water and polymer.</td>
</tr>
</tbody>
</table>
Effects of the Instrument Door State on Wizard Tasks

Follow the suggestions below to use the wizards effectively when the door is open or closed.

**IMPORTANT!** Whenever the door is closed (whether or not a wizard is open, or an automated procedure is in progress), the autosampler moves while determining position (initialization). Always wait for the autosampler to stop moving, and the green status light to illuminate before starting any automated procedures. If you accidentally start an automated procedure while the autosampler is moving, an error may be displayed in the Data Collection Software event window. However, you should be able to complete the wizard. Restart the instrument and the Data Collection software.

<table>
<thead>
<tr>
<th>Wizard-Based Task</th>
<th>Status of Instrument Door</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IMPORTANT!</strong> Do not open or close the instrument door while an automated procedure is in progress. Leave the door in the starting state (whether open or closed) until the automated procedure is complete.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Begin an automated procedure</td>
<td>Open</td>
<td>The procedure continues when the door is closed, and after the autosampler moves to initialize. If you open the door again, the procedure pauses until the door is closed.</td>
</tr>
<tr>
<td>Begin an automated procedure</td>
<td>Closed</td>
<td>The procedure pauses if the door is opened. Close the door again to resume the procedure.</td>
</tr>
<tr>
<td>Click <em>Fill Array</em></td>
<td>Open</td>
<td>The procedure does not start; the door must be closed.</td>
</tr>
<tr>
<td>Perform an automated procedure</td>
<td>Closed</td>
<td>The green status light remains on (not flashing).</td>
</tr>
<tr>
<td>Perform an automated operation</td>
<td>Open</td>
<td>The yellow status light flashes.</td>
</tr>
</tbody>
</table>

**Note:** Regardless of whether or not automated procedures are in progress during wizard use, if the instrument door is:
- Closed, then the green status light remains on (not flashing)
- Open, then the yellow status light flashes
Cleaning the Polymer Delivery Pump (PDP) and Lower Polymer Block

Guidelines

**WARNING** CHEMICAL HAZARD. POP-7™ polymer may cause eye, skin, and respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves. Use for research and development purposes only.

- Do not expose the polymer blocks to organic solvents.
- Do not use sharp or pointed instruments to remove dried polymer from the polymer blocks.
- Do not use water >40 °C to clean the polymer blocks.

Frequency

- Clean the exterior every 7 days, when polymer is replenished.
- Flush the polymer delivery pump water trap once per week.
- Clean the polymer delivery pump chamber, channels, and tubing once per month.
Cleaning the Polymer Delivery Pump Chamber, Channels, and Tubing

1. Run the Water Wash wizard by selecting Wizards > Water Wash Wizard on the menu bar.

2. Inspect the channels of the Pump and Lower blocks for any contaminants. Repeat the Water Wash wizard until contaminants are removed.
Flushing and Filling the Water Trap

CHEMICAL HAZARD. POP-7 polymer causes eye, skin, and respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

Overview

The polymer delivery pump water trap should be flushed at least once per week to wash out any diluted polymer that may have passed through the water trap seals. Some air bubbles in the water trap are acceptable and do not affect performance. Leave the trap filled with either distilled or deionized water.

To flush the water seal trap:

1. Fill the supplied 20mL, all-plastic Luer lock syringe (PN 4324463) with distilled or deionized water. Expel any bubbles from the syringe.

   Note: Do not use a syringe smaller than 20 mL. A smaller syringe may generate excessive pressure within the trap.

2. Attach the syringe to the forward-facing Luer fitting at the top of the pump block. Hold the fitting with one hand while threading the syringe onto the fitting with the other hand.

3. Open the Luer fitting by grasping the body of the fitting and turning it and the attached syringe approximately one-half turn counterclockwise.

4. Open the exit fitting at the top left side of the pump block by turning it approximately one-half turn counterclockwise.

5. Hold an empty tube or beaker under the exit fitting to receive approximately 5 mL of waste. Flush the trap by pushing steadily on the syringe plunger.

   IMPORTANT! DO NOT USE EXCESSIVE FORCE. Take approximately 30 seconds to flush 5 mL of either distilled or deionized water through the trap.

6. Close the fittings by turning each clockwise, in the following order, until the fittings seal against the block:

   a. Luer fitting.
   b. Exit fitting.

   IMPORTANT!: Do not over-tighten the fittings. The fittings require only enough tightening to prevent water leaks. Excessive tightening can damage the fittings.

Notes
7. Remove the syringe from the Luer fitting. Hold the fitting with one hand while turning the syringe counterclockwise with the other hand.
Storing a Capillary Array

**CAUTION**  To maintain serviceability during storage and to prevent damage to the arrays, keep both ends of the capillary array immersed in 1× run buffer. Failure to do so may result in array damage.

**WARNING** CHEMICAL HAZARD. Running Buffer with EDTA causes eye, skin, and respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

1. Remove the capillary array from the instrument using the Install Array wizard.

**IMPORTANT!** Do not choose **Discard Array** if the array will be used again.

2. Put 80 mL of 1× run buffer in the capillary array header shipping cover.

3. Lower the capillary tips of the array header into the shipping cover and lock the header onto the cover. The tips of the capillaries should be immersed in buffer.

4. Clip the detection cell window cover onto the detection cell.

5. Attach the detection cell with its cover to the storage post on the array frame.

6. If the array knob and double-tapered ferrule are on the array tip:
   a. Remove them and rinse them with deionized water.
   b. Dry the parts with a lab wipe.
   c. If they are not to be used immediately, store them in a safe place.

7. Clean the array tip carefully with a lab wipe moistened with deionized water.

Notes
8. Attach the array tip shipping vial filled with 1X run buffer to the array tip. Loosen the vial cap slightly, insert the tip and then tighten the cap.

9. Clip the vial with the array tip onto the array frame.

10. Store the capillary array upright in a safe area.

**IMPORTANT!** Check the 1X run buffer levels in the shipping cover and vial at least once a week; replenish the buffer as necessary to keep both ends of the capillaries immersed in buffer.
Performing a Short-Term Shutdown

Perform the short-term shutdown procedure if you will use the instrument again in 7 days or less.

⚠️ **WARNING** CHEMICAL HAZARD. **POP 7™ polymer** may cause eye, skin, and respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves. Use for research and development purposes only.

⚠️ **WARNING** CHEMICAL HAZARD. **Running Buffer with EDTA** may cause eye, skin, and respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

**Materials Required**

- 1X Run Buffer
- POP-7 polymer
- Deionized water
- Lab wipes
- Gloves
Performing a Short-Term Shutdown

1. Close the instrument door.

2. Press the tray button to bring the autosampler to the forward position.

3. After the autosampler stops moving and the green status light illuminates, open the instrument door.

4. Remove the buffer, water, and waste reservoir assemblies from the instrument.

5. Disassemble each reservoir assembly and empty the contents of the reservoirs into an aqueous waste container.

6. Rinse each reservoir using deionized water.

7. Dry the reservoirs using lint-free wipes.
8. Fill and assemble the reservoirs.

9. To prevent damage to the capillary array, inspect each reservoir assembly and verify that the:
   - Septa fit snugly and flush on the reservoir
   - Rubber gasket around the edge of the reservoir cap is seated
   - Plate retainer holes and the septa strip are aligned

10. Dry the reservoirs using lint-free wipes.
11. Connect the Buffer reservoir plate base cable to the heater outlet within the instrument.

**IMPORTANT!** After placing the buffer reservoir, make sure the cable is out of the way of the autosampler.

12. Place the Water and Waste reservoirs in the instrument. Load the three reservoirs in the following order:
   a. Buffer reservoir
   b. Water reservoir
   c. Waste reservoir

13. Close the instrument door.

14. Press the instrument tray button.

15. Press the instrument power button.
Chapter 1 Maintenance
Performing a Short-Term Shutdown

16. Power off the computer:
   a. Select Start > Shutdown.
   b. In the Shut Down Windows dialog box, select Shut down from the drop-down list.
   c. Click OK.
   d. Press the monitor power button.
Deleting Data from the Database

**IMPORTANT!** The Cleanup Database utility deletes all run data and plate records in the database. Before running the utility, be sure that all runs have been extracted from the database.

**IMPORTANT!** Do not manually delete spectral plate records or spectral information—doing so permanently deletes spectral information.

1. In the navigation pane of the Data Collection Software, click **GA Instruments > Database Manager.**
   The Database Manager opens.

2. Click **Cleanup Processed Plates.**
Chapter 1 Maintenance
Deleting Data from the Database

The Cleanup Database dialog box opens.

3. Click **OK**.

**Note:** You do not need to reimport the spatial and spectral calibrations or the custom run modules.

**Note:** It may take several minutes to clean up the database.
Maintaining Adequate Space for Database and Sample Data

To ensure that you have sufficient disk storage space, you need to regularly:

- Archive data, see page 23
- Delete unneeded files, see page 22
- Empty the recycle bin
- Defragment the drives, see page 24

Pre-Run Automatic Disk Space Checks

Before a run or batch of runs, the Data Collection software automatically checks if sufficient space is available to store the database and sample file data you create.

The Data Collection software displays a warning message to remove data and/or clean up the database when the database is full. The message displays in the Error pane of the Instrument Status window and in the Event Log window. Also, the status light in the bottom left corner of the data collection window flashes red.

Full Database Error

To view error messages, click **GA Instruments** > **ga3730** > your instrument name > **Instrument Status** > **Event Log**.

**IMPORTANT!** Runs can not be started until the data is removed from the drive and/or database is cleaned up.
Chapter 1 Maintenance
Maintaining Adequate Space for Database and Sample Data

Checking Available Disk Space on Drive E

1. In the navigation pane of the Data Collection Software, click
   GA Instruments > Database Manager.
   The Database Manager opens.

   ![Database Manager Image]

2. If there is insufficient space on drive E:
   a. Archive the sample files to a CD-RW (see page 23) or another volume.
   b. Delete the sample file data from the drive E and then empty the Recycle Bin.

Notes
Archiving Data

Creating a Data CD

Use the Roxio Easy CD Creator™ 5 software that came with your Dell™ computer. Use this software to archive data to a CD. The software is also part of the CD set you received with your Dell computer.

To archive data:

1. Select Start > Programs > Roxio Easy CD Creator 5 > Applications > Easy CD Creator.

   The Untitled - Easy CD Creator dialog box opens.

2. For help creating a data CD, select Help > Contents and Index.

3. In the navigation pane, select Making Data CDs for Archiving and Sharing > Making a Data CD.

4. Follow the instructions for creating the CD.
Defragmenting the Computer Hard Drive

Because fragmentation of files decreases the performance of both the data collection software and the computer operating system, defragment the computer hard drive:

- At least once every month.
- Before fragmentation reaches 10%.

### Defragmenting the Hard Drive

1. In the Windows desktop, select **Start > Programs > Accessories > System Tools > Disk Defragmenter.**

2. Select drive **E**.

3. Click **Defragment**.

   The Defragmentation Complete dialog box when defragmentation is complete.

4. In the Defragmentation Complete dialog box, click **Done**.

5. In the Computer Management dialog box, click **X**.

---

Notes
Troubleshooting

Spatial Calibration

Peak Does Not Contain an Orange Cross

**IMPORTANT!** If the pluses are not placed at the tip of each peak the data quality may be compromised.

**Note:** The cross positions cannot be altered after you accept the calibration data.

To move an orange cross:
1. Magnify the view of the peak without a cross.
2. Determine the peak pixel position.
3. Change the value for the incorrectly positioned cross.
4. Click outside of the box.

If the Calibration Fails

If the calibration fails, or if you do not like the appearance of the profile, perform the following procedure:

**WARNING** CHEMICAL HAZARD. Methanol is a flammable liquid and vapor. Exposure causes eye and skin irritation, and may cause central nervous system depression and nerve damage. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves

1. Repeat the spatial calibration (see “Performing Spatial Calibration” in the Applied Biosystems 3730/3730xl DNA Analyzer Getting Started Guide PN 4359476).
2. If the calibration fails again:
   a. Follow the Bubble Remove wizard to remove bubbles and to fill the capillaries with polymer.
   b. Repeat the spatial calibration (see “Performing Spatial Calibration” in the Applied Biosystems 3730/3730xl DNA Analyzer Getting Started Guide PN 4359476).

Notes
3. If the calibration fails again:
   a. Open the instrument door.
   b. Open the oven door.
   c. Open the detection cell door and then turn the cam knob 1/4-turn clockwise (pointer left).
   d. Pull the pump and lower polymer blocks forward until the detection cell comes out of the detection block.
   e. From the pump block remove the:
      - Tip of the capillary array
      - Array knob
      - Ferrule
   f. Add one drop of methanol to a sterile swab or lint-free wipe and then use the swab or wipe to gently clean the front surface of the detection cell.

   g. Reinstall the tip of the capillary array, array knob, and ferrule into the pump block.
   h. Push the pump and lower polymer blocks back against the pump panel, making sure that the buffer valve lever properly engages the buffer pin valve.
   i. Carefully place the detection cell into the detection block and then secure it by rotating the cam knob 1/4-turn counterclockwise (pointer down).
   j. Close the detection cell door.
   k. Close the oven door.
   l. Close the Instrument door.
   m. Using the Bubble Remove wizard, remove all bubbles. Pay particular attention to the array port area.
   n. Repeat the calibration (see “Performing Spatial Calibration,” in the Applied Biosystems 3730/3730xl DNA Analyzer Getting Started Guide PN 4359476).

4. If the calibration fails again:
   a. Perform steps 3a through 3c.
   b. Reposition the capillary array window in the detection cell.
   c. Perform steps 3j through 3m.
   d. Repeat the calibration (see “Performing Spatial Calibration,” in the Applied Biosystems 3730/3730xl DNA Analyzer Getting Started Guide PN 4359476).

5. If calibration fails again, replace the capillary array. For help see, Repeat the calibration (see “Installing the Capillary Array,” in the Applied Biosystems 3730/3730xl DNA Analyzer Getting Started Guide PN 4359476)
## General Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No signal</td>
<td>Incorrect sample</td>
<td>Replace samples with fresh samples prepared with fresh Hi-Di™ formamide.</td>
</tr>
<tr>
<td></td>
<td>preparation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>WARNING</strong> CHEMICAL HAZARD. Formamide causes eye, skin, and respiratory tract irritation. It is a possible reproductive and birth defect hazard. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.</td>
</tr>
<tr>
<td></td>
<td>Air bubbles in sample</td>
<td>Centrifuge samples to remove air bubbles.</td>
</tr>
<tr>
<td></td>
<td>tray</td>
<td></td>
</tr>
<tr>
<td>Spectral calibration fails, or &quot;No candidate</td>
<td>Clogged capillary</td>
<td>Refill the capillaries using manual control. Look for clogged capillaries during capillary fill on the cathode side.</td>
</tr>
<tr>
<td>spectral files found&quot; message displayed</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Insufficient filling of</td>
<td>Check for broken capillaries and refill the capillary array.</td>
</tr>
<tr>
<td></td>
<td>array</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Expired spectral</td>
<td>Check the expiration date and storage conditions of the spectral standards. If necessary, replace with a fresh lot.</td>
</tr>
<tr>
<td></td>
<td>standards</td>
<td></td>
</tr>
<tr>
<td>Spikes in the data</td>
<td>Expired polymer</td>
<td>Replace the polymer with a fresh lot using the Change Polymer Wizard.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>WARNING</strong> CHEMICAL HAZARD. POP-7™ polymer causes eye, skin, and respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.</td>
</tr>
<tr>
<td></td>
<td>Air bubbles, especially</td>
<td>• Refill the capillaries using the Bubble Remove wizard.</td>
</tr>
<tr>
<td></td>
<td>in the polymer</td>
<td>• Bring the polymer to room temperature.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Replace expired polymer.</td>
</tr>
<tr>
<td></td>
<td>Possible contaminant in</td>
<td>Replace the polymer using the Change Polymer wizard.</td>
</tr>
<tr>
<td></td>
<td>the polymer</td>
<td></td>
</tr>
<tr>
<td>Instrument fittings leak</td>
<td></td>
<td>Finger-tighten all fittings. Do not overtighten.</td>
</tr>
<tr>
<td>Brown or black deposits in the lower</td>
<td></td>
<td>Replace the lower polymer block.</td>
</tr>
<tr>
<td>polymer block or,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Burnt smell around the lower polymer block</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Air bubbles</td>
<td>Loose fittings</td>
<td>Use the Bubble Remove wizard. For persistent bubbles, change the system over to water, then back to polymer using wizards.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Polymer in the buffer jar during filling (Schlieren lines, polymer streaking into buffer) | • Leaking buffer pin valve  
• Arcing  
• Adjustment needed | Contact Applied Biosystems to have a Service Engineer adjust the pin valve.  
or,  
Replace the lower polymer block. |
| Polymer comes out of the polymer tubing during pump fill stroke.        | Check valve leaks. Remove the polymer bottle to see the check valve.          | Remove the pump from the instrument and push 100 mL of DI-water through the check valve with a 50-cc syringe and adapter. |
| “Tray on deck does not match Tray Type in run setup” error message displayed. |                                                                              | Contact Applied Biosystems to arrange a Service Engineer visit.                  |
# Index

## A
- archiving data 19
- assumptions for using this guide v

## B
- buffer reservoir assembly diagram of 16

## C
- capillary array storing 12
- channels cleaning 10
- cleaning channels 10
- instrument 3
- lower polymer block 9
- PDP chamber 10
- pump block 9
- tubing 10
- conventions in this guide v

## D
- data archiving 19
- deleting from database 21
- data CD, creating 20
- database deleting data from 21
- deleting records from 21
- full error 18
- maintaining adequate space for 18
- deleting records from hard drive 23
- disk maintaining adequate space 16
- pre-run space checks 18

## E
- E drive checking for available space on 19

## G
- Guide, how to use this v

## H
- hard drive defragmenting 21, 23
- deleting records from 23
- How to Use This Guide v

## I
- instrument cleaning 3
- door closed, effects on wizards 8
- door open, effects on wizards 8
- instrument door status of 8

## L
- lower polymer block cleaning 9

## M
- maintenance as-needed tasks 2
- daily tasks 1
- monthly tasks 2
- overview 1
- weekly tasks 2

## O
- orange cross, peak does not contain 25

## P
- PDP chamber, cleaning 10
- pump block, cleaning 9

## R
- reservoir buffer 16
- waste 16
- water 16
Index

S
sample data, storage of
  18
shutdown, performing short-term
  14
spatial calibration
  failed
    25
troubleshooting
    25
spectral calibration
  troubleshooting
    27
storing
  capillary array
    12

T
text conventions
  v
tubing, cleaning
  10

W
Waste
  16
water reservoir assembly
  diagram of
    16
water trap
  filling
    11
  flushing
    11
  overview
    11
wizards
  Bubble Remove
    5
  Change Polymer
    5
effect of instrument door state on
  functions
    3
  Install
    5
  Instrument Shutdown
    5
  overview
    5
types
  3
typical conditions for using
  5
  Water Wash
    5
Worldwide Sales and Support

Applied Biosystems vast distribution and service network, composed of highly trained support and applications personnel, reaches 150 countries on six continents. For sales office locations and technical support, please call our local office or refer to our Web site at www.appliedbiosystems.com.

Applera is committed to providing the world's leading technology and information for life scientists. Applera Corporation consists of the Applied Biosystems and Celera Genomics businesses.

Headquarters
850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free (in North America): +1 800.345.5224
Fax: +1 650.638.5884

04/2005